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NORTHEASTERN BAPTIST COLLEGE WRITING STYLE GUIDE 

INTRODUCTION TO TURABIAN 

Kate L. Turabian's Manual for Writers of Research Papers, Theses, and Dissertations presents two basic source 

documentation systems, a notes-bibliography style and an author-date style, along with other style conventions, 

instructions for document design, and rules for ethical research. These styles in Turabian’s Manual are a specialized 

version of those in The Chicago Manual of Style (Chicago style).  

Chicago style outlines the systems of citation used by most writers in the sciences and in the humanities. The notes-

bibliography style is used widely in history, literature, music, philosophy, theology, classics, and biblical studies, and 

it presents bibliographic information in the form of footnotes (or endnotes) and a bibliography.  

As the dissertation secretary at the University of Chicago in the 1930s, the late Kate Turabian would assess each 

doctoral thesis submitted to her office. Not surprisingly, she ended up creating a short pamphlet outlining how to 

correctly style college dissertations. This pamphlet eventually became A Manual for Writers, her simpler and more 

specific version of Chicago style, targeted toward research writers.  

The latest Turabian Manual (9th edition, 2018) is revised by the University of Chicago Press Editorial Staff and is fully 

aligned with standards of The Chicago Manual of Style (17th edition, 2017). This edition of A Manual for Writers is an 

especially valuable resource because it incorporates The Craft of Research (4th edition, 2016).  

 A Manual for Writers of Research Papers, Theses, and Dissertations, 9th edition (2018), is the official style guide 

at Northeastern Baptist College.   

NOTES-BIBLIOGRAPHY STYLE   

Turabian style has two citation systems: notes-bibliography (a footnote system) and author-date (a parenthetical 

system, sometimes called a “reference-list” system). NEBC exclusively uses the notes-bibliography style of citation, 

requiring footnotes and a bibliography, as outlined in chapters 16 and 17 of Turabian’s Manual. NEBC allows for in-

text citations only in special cases described below.  

CLASSICAL CITATION EXCEPTION  

A classical citation is a brief parenthetical reference to a classical or sacred source that has its own system of 

reference numbers, such as chapter and verse in the Bible (§16.4.3.1). NEBC students should normally cite the Bible 

neither in footnotes nor with page numbers, but in brief parenthetical references to abbreviated book names with 

numbers of chapter, verse, and section (see §17.8.1 for citing classical works, §17.8.2 for citing the Bible, and “Citing 

Scripture” on page 11 of this guide for abbreviations and exceptions).  A footnote for Bible references will only be 

used on first quotation or where a content note is needed. 
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COUNSELING & BUSINESS EXCEPTION  

All written assignments in Christian Counseling courses, Business Administration courses, and select General 

Education courses must adhere to the APA style manual: American Psychological Association Publication Manual of 

the American Psychological Association, 7th edition (2020). APA is a source documentation system for social sciences 

and uses a parenthetical/bibliography system of citation.  

PROFESSORIAL EXCEPTION  

Professors have the authority to request specific formatting that may fall outside the guidelines set by Turabian or 

by this Writing Style Guide (for example: your professor may prefer endnotes to footnotes, and request that all 

papers for the class use endnotes). Any individual professor’s requirements for style will always supersede all 

manuals and guides for those writing assignments given by that individual professor in his/her specific course. 

Students should follow Turabian rules exactly as set forth in this guide unless the professor requests otherwise.  

SINGLE SOURCE EXCEPTION  

When a paper references a single source or a primary source throughout (such as the book being reviewed in a book 

review; §16.4.3.1), it is acceptable to cite that source parenthetically, with page numbers only. A full reference to 

the source will still need to be made, either in a bibliography page or as the title of the paper. When in doubt, consult 

the professor.  

HOW TO USE YOUR MANUAL  

 Your Turabian Manual is split up into three parts: Part 1: Research and Writing, Part 2: Source 

Citation, and Part 3: Style, with an Appendix. Each part is broken down into chapters and 

sections, which can easily be referred to using the chapter, section, and sub-section numbers (e.g. 

§17.1.2). The NEBC Writing Style Guide references Turabian throughout using this pattern.  

 

 

Part 1: Research and Writing includes valuable information concerning the content of your paper, such as how to 

ask a research question and create a thesis, how to find useful and relevant sources on your topic, how to plan your 

argument, how to write a draft, how to craft an introduction and conclusion, how to revise your draft, and more. 

This section is a great resource for understanding the kind of logical standards, organization, sources, and 

conventions that are used in academic writing.   

“Your first duty as researcher is to get the facts right. Your second duty is to tell readers where 

the facts came from. To that end, you must cite the sources of the facts, ideas, or words that 

you use in your paper” (139). 
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Part 2: Source Citation gives an introduction to the concept of citation itself in Chapter 15, offers an overview of the 

basics of notes-bibliography style in Chapter 16, and provides instructions for specific types of sources along with 

examples in Chapter 17. Once you have a grasp of the basics of citation, you will likely use Turabian mainly to refer 

to Chapter 17, which is illustrated with many examples of footnote (N) and bibliography (B) entries for print and 

electronic sources. (Chapters 18 and 19 cover author-date style, which NEBC does not use. The student would be 

wise to mark off or tape off this section to avoid using it.) 

Part 3: Style + Appendix will be useful to you for making sure formatting, grammar, and other stylistic issues are 

correct. The Appendix includes several images of correct paper formatting, such as the title page for a class paper 

(§A.2.1.2, Figure A.1). You can also look up any topic in the index at the back of the book.  

HOW TO SET UP THE DOCUMENT  

Following are the general formatting requirements for your paper. The guidelines below assume the use of Microsoft 

Word© as the word processor; those using Pages, Google Docs, etc., should refer to integral or online helps for those 

specific programs.  

MARGINS & ALIGNMENT  

Set a margin of 1 inch on all four sides of each page, including the title page and bibliography page(s). Text pages 

should be aligned or justified to the left, with right margins not justified.  

 

TYPEFACE  

Use Times New Roman 12-point (size) font throughout the entire paper, including page numbers. Footnotes should 

be in Times New Roman 10-point (size) font.  

Times New Roman 12-point font            Times New Roman 10-point font  

 

In some cases, a foreign language such as Hebrew, Aramaic, Greek, or Arabic may require specialized fonts. In such 

a case the specialized font should only be used for the foreign language text and all text in that language should be 

in the same font. The foreign language text should be in the same size font (12 point) as the document text. All text, 

including title page, headings, and so on, should be in black. Do not use other colors or decorative fonts (charts, 



NORTHEASTER N BAPTIST COLLEGE WRITING STYLE GUIDE   

diagrams, or photos/graphics which use color may be used as appropriate). Links and URLs will show as blue in 

Word© by default. You must change these hyperlinks to black. Italicize book titles, magazine titles, journal titles, 

and titles of longer musical compositions; enclose poem titles, articles titles, and shorter composition titles in 

quotation marks.      

Journal of the Evangelical Theological Society                    “The Road Not Taken”  
     Journal Title      Poem Title  

 

SPACING  

Double-space all text in papers, including the title page, but the following items should be single-spaced internally 

with a blank line separating items (§A.1.3):   

• footnotes (§16.3.4.1)  

• bibliography (§A.2.3.5)  

• block quotations (§25.2.2)   

• epigraphs (§25.2.2.3)  

For spacing between sentences, use a single space (not two) after the terminal punctuation (§A.1.3).   

INDENTATION   

Indent the following ½ inch (i.e. one tab, or five spaces) from the left margin:  

• first line of paragraph   

• block quotations  

• first line of footnote  

• second and all subsequent lines of a bibliography entry (hanging indent)    

PARAGRAPHS  

The first line of each paragraph should be indented ½ inch and there should be zero points of additional spacing 

between paragraphs (not Word’s default 10 points of space after each paragraph). To correct the default paragraph 

spacing, highlight the entire document (ctrl-A), refer to the Home tab, select Paragraph settings/options, look to the 

Spacing section, and change “After: 10 pt” to “After: 0 pt.” Click "Set as Default" to make this the default formatting 

for future documents  

PAGINATION  

Page numbers should begin on the first page of text (title page is not numbered) and should be placed in the upper-

right corner of the header. Just like the text, page numbers should be in Times New Roman 12-point font size. The 

first page of text should be page 1; do not count the title page.  
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To insert page numbers and start numbering on the first page of the text, follow these three steps:   

1: Insert page number: From the Insert tab, select Page Number, then select Top of Page, and choose option 3 

(flush right).   

2: Different first page: With the header still open (viewing Header & Footer Tools), view Design, and check the 

box for Different First Page. Now page numbering will not appear on the title page.  

3: Start at zero: With the header still open (viewing Header & Footer Tools), click Page Number, then select 

Format Page Numbers, and set Page numbering to Start at: 0.  

4: Select OK, and close the header. Now page numbering will start at 1 on the first page of text.    

FOOTNOTES  

Whenever you reference or otherwise use material from a source, there must be a superscript numeral (at the end 

of the sentence or clause containing the referenced material, §16.3.2) that directs the reader to the citation of the 

same number at the bottom of the page: the footnote. To create a footnote, place your cursor after the ending 

punctuation, and under the References tab, click Insert Footnote. A superscript numeral will be placed within your 

text and the corresponding footnote number will appear at the bottom of the page, ready for you to enter your 

citation.  

• Each footnote should begin with its reference number in 10 point Times New Roman font, with a period 

and a space before the citation (§16.3.4).  

10pt Times New Roman with period and space  

 12. Mark Ballard, Normal’s Journey (Maitland, FL: Xulon Press, 2007), 23-25. 

 
Wrong font. No period. 

 12 Mark Ballard, Normal’s Journey (Maitland, FL: Xulon Press, 2007), 23-25. 

 
Should not be superscript. 

 12 Mark Ballard, Normal’s Journey (Maitland, FL: Xulon Press, 2007), 23-25. 

• When more than one source is referenced in a single sentence, do not insert more than one reference 

number (such as 7,8). Instead, use one number and create a footnote that lists each source separated by 

semicolon. This is called a “complex” footnote (§16.3.5).  
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• Indent footnotes on first line; single-space within each note, double-space between notes.  

_______________________ 

  

11. Joseph Ferguson, Admissions Practices for the Christian College: Everything You Didn’t 

Know You Needed to Know, ed. Timothy Groos (Bennington, VT: Northeastern Baptist College Press, 

2016), 108-9.  

 
12. Mark Ballard, Normal’s Journey (Maitland, FL: Xulon Press, 2007), 23-25. 

 

• Learn more about footnotes on page 7 of the NEBC Writing Style Guide. Remember, for every individual 

work that you cite in your footnotes, you will need an entry in your Bibliography or Works Cited page. As 

Turabian explains, “Although the same information appears in both notes and bibliography, readers need 

it in both places because they use notes and bibliographies differently. Notes let readers quickly check the 

source of a particular reference without disrupting the flow of their reading. A bibliography shows readers 

the extent of your research and its relationship to prior work” (§16.2).    

TITLE PAGE  

Create a title page for each paper unless instructed otherwise. This is the page that gives all the identifying 

information about your paper and the assignment. NEBC uses the simpler “class paper” style title page (see §A..2.1.2, 

Figure A.1, and the sample at the end of this Writing Style Guide).   

• Center and double-space all lines of text on the title page.  

• Paper title in bold and capitalized headline-style (not all-caps; see §22.3.1.1), should not exceed two lines 

and should be placed 3” from top of page (i.e. 2” below the 1” top margin). For papers with a title and 

subtitle, add a colon after the title and place the subtitle underneath on a second line. If the paper title 

includes a work’s title that would normally be italicized or in quotes, italicize or use quotes as usual.  

• Several lines below the paper’s title, include the following information on separate lines.  

o Student Name  

o Class Name  

o Professor Name (Turabian does not require this, but NEBC does)  

o Date Assignment is Due  

The last line of this information should fall roughly 2-3” from the bottom edge of the paper. Since we have four lines 

of assignment information and you may have 1 or 2 lines for the title, this will vary somewhat from paper to paper. 

Strive for an attractive balance. 
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For a short assignment (as opposed to a formal essay), the professor may specify no title page. If so, generally put 

the same personal and course information at the top left (below the 1" margin), double space, include the title of 

the assignment, centered and bold, double space again, and begin the text.  

BIBLIOGRAPHY OR WORKS CITED PAGE  

The bibliography at the end of your paper is a list of all the sources that you cited in the body of your writing. Turabian 

allows bibliographies to also include sources that were consulted but not specifically cited within the paper. At NEBC, 

we use the titles “Works Cited” or “Bibliography” to differentiate between the two types of bibliographies.  

Title your page Works Cited when it contains only the sources that you specifically cited within your paper. If the list 

also contains sources that you read but didn’t cite in the paper, title it Bibliography. Use the bibliography option 

when you want to show the full extent of your research. For example, if you read 25 journal articles for a paper on 

Baptism, but cite only 15 of those articles in your paper, the full scope of your work may not be represented. Instead, 

you could have a bibliography at the end of your paper with an entry for each of the 25 articles you read. Beware, 

however, of “padding” your bibliography. Even in a bibliography, you must only include those works that you 

possessed and read. DO NOT include works referenced by others which you did not read, works you requested from 

another library but did not receive in time, works you only read a review or summary of, and so on.  

• The page number should follow the last page of text in consecutive order.  

• The title should be centered and bold at the top of the page; do not repeat the title on subsequent pages 

of the bibliography. Leave two blank lines after the title before inputting the first bibliography entry 

(§A.2.3.5).  

• Each entry must be in “hanging indent” style (first line flush with left margin, each subsequent line of 

entry indented ½ inch), single-spaced within it, with an extra space between entries. To set a hanging 

indent, highlight text, then from the Home tab, select Paragraph settings/options; under the Indentation 

section, choose “Hanging” from the Special dropdown.  

• Arrange the entries alphabetically by authors' last names.  If an entry has no author, use the first word of 

the title instead, ignoring articles (a, an, the). An easy way to do this in Word is to use the Sort tool in the 

Paragraph section of the Home tab.  

• Break up long URLs after marks of punctuation such as / = or &.  

See the back of this Writing Style Guide for a sample bibliography page.  

HOW TO CITE SOURCES  

Ethical scholarship is essential at NEBC. Central to being an honest and responsible researcher and writer is giving 

credit to the originator of ideas and words that are not your own (learn more about plagiarism in the Academic 
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Handbook). The system we use for giving credit is the notes-bibliography system. In order to be clear, it is important 

to include as much information about the source as possible, in an organized way. Turabian prescribes a specific 

type and order of information along with specific punctuation that you will need to use for each footnote and 

bibliography entry.  

THE BASICS  

The basic types of information to include about almost any kind of source are: Who wrote it; Where the information 

exists (in a book, an article, on a webpage, etc.); and When, where, and by whom was it published. See Chapter 17 

in Turabian for instructions and examples for citing many other kinds of sources.  

Let’s say you check out this book and have found a quote from it that you want to use in 

your paper. We will walk through citing it correctly.   

Everyone has a different style and system for how they stay organized in the drafting 

stage of a paper. One of the best practices is to go ahead and create a bibliography entry 

first for any book you think you may use information from in your paper. In this case, you 

already know that you will be using a quote from this book, so you are ready to add the 

quote to your draft and make your bibliography entry and footnote.   

First, we’ll look at the basic parts of a bibliography entry, and then find that information in the book.  

Author Last Name, Author First Name. Title of Book. City, State Abbreviation: 

Publisher, Year.  

 
Use the author's name as it appears on the title page. It is often the same as what 

appears on the front cover. You should check to make sure that Harold Bloom is the 

author, not the editor, and you don’t find any other names for editors or translators 

on the front cover, the inner title page, or copyright page. So, you add author name 

and book title to the entry. (See §17.1.2.1 for special elements in titles, like this one 

which has a question mark that replaces the standard period in the arrangement of 

the citation elements.)  

  

 Bloom, Harold. Where Shall Wisdom be Found? City, State Abbreviation: 

Publisher, Year. 
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Next, you look at the inside title page and see the publisher and the publisher city, and 

add those to the entry (See §17.1.6.1 for publishers outside the US or unknown 

publishers; see §17.1.6.2 for parts of publisher names that can be omitted). Contrary to 

Turabian’s guidelines, at NEBC students should always include the state abbreviation 

after the city of publication. If more than one city is listed, use the first.  

  
City  

 

Bloom, Harold. Where Shall Wisdom Be Found? New York, NY: Riverhead 

Books, Year. 
 

Then, you flip the page and find the publication year on the copyright page (where you 

find it in most books, though this book also had the year on the inside title page). 

Sometimes this can be tricky if there are several copyright dates listed. Generally, the rule 

is to use the most recent date (§17.1.6.3).  

 

Bloom, Harold. Where Shall Wisdom Be Found? New York, NY: Riverhead 

Books, 2004.  

Bibliography entry done! Now, it’s time to create the footnote. Pay close attention to the punctuation that separates 

the various information in your bibliography entry and footnote—it’s not negotiable. Note that each citation ends 

in a period, the author name is ordered differently between bibliography entries and footnotes, footnote 

information is separated mostly by commas while bibliography information is separated mostly by periods, and the 

publication info is in parentheses for the footnote.  

1. Author First Name and Last Name, Title of Book (City, State: Publisher, Year of 

Publication), Page(s). 

 Following the basic form for a footnote above, all you need to do is re-enter the information listed in your 

bibliography entry and add the specific page(s) of the quote you are using in your paper. Do not add “page” or “p” 

or “pp” with the page numbers. The traditional method of making the footnote number superscript without any  
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period or space before the beginning of the note is still permitted by Turabian (§16.3.4), and this method may be 

used if the professor prefers or permits it. 

1. Harold Bloom, Where Shall Wisdom Be Found? (New York, NY: Riverhead Books, 

2004), 76. 

Now you should have a basic grasp of how to find the information that you will need for your citations. Again, it will 

be essential to consult Chapter 17 of your Turabian Manual in order to correctly cite other types of works.  

SHORTENED FOOTNOTES  

There are two unique footnote styles that come about when you cite a work more than once in your paper: 

shortened footnotes and Ibid.   

A shortened footnote is what it sounds like: a shortened version of a footnote. The rule is that the first time you cite 

a certain work in your paper, you need to give the full version of the citation. Any subsequent reference to that same 

work warrants only a shortened version: with the author’s last name, a shortened book/article title, and the page(s).  

13. Harold Bloom, Where Shall Wisdom Be Found? (New York, NY: Riverhead Books, 

2004), 76. 

15. Bloom, Wisdom, 76.  

Another way to understand it is that all the footnotes in your paper should be shortened versions, except for the 

first time you cite each individual work (and except for use of ibid.). Note that you do not need to say “page(s),” or 

“p” or “pp” with the page number.  

USING IBID.  

Ibid. is an abbreviation of a Latin term (ibidem) that means “in the same place.” Being an abbreviation, ibid. always 

ends with a period. It is not, however, italicized as most foreign terms are (cf. §22.2.1 and §16.4.2). Use ibid. when 

you cite the same work consecutively. If you are again referencing the very same page of the source in the previous  
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footnote, write Ibid., and if you are referencing the same source as in the previous footnote but a different page, 

write Ibid. with a comma and the specific page number(s), ending with a period.  

13. Harold Bloom, Where Shall Wisdom Be Found? (New York, NY: Riverhead Books, 

2004), 76. 

14. Joseph Ferguson, Admissions Practices for the Christian College: Everything You 

Didn't Know You Needed to Know, ed. Timothy Groos (Bennington, VT: Northeastern Baptist 

College Press, 2016), 108-9. 

15. Bloom, Wisdom, 76. 

16. Ibid. 

17. Ibid., 78. 

18. Ferguson, Admissions Practices, 4.  

19. Ibid. 

Watch that your use of shortened notes and ibid. remains correct throughout the paper. For instance, the first time 

a student cites the book Where Shall Wisdom Be Found? (FN 13 in the example), the student needs to give the full 

citation with publisher info, copyright date, etc. After that initial reference, any footnote for that same book will be 

a shortened version (FN 15). Additionally, if the student cites from Where Shall Wisdom be Found? twice (or more) 

in a row, the student will use ibid. in place of a footnote for the second (and any consecutive) repetition of the source 

(FNs 16 and 17). If you continue to cite that same source onto the next page, use a shortened note to begin the 

footnotes on the new page so that your reader doesn’t have to flip back to remember what work the ibid. is 

referencing (§16.4.2). This will require a last read-through before printing/submitting your paper to ensure that Ibid. 

is not the first note on any page. One useful strategy is to use shortened forms for all footnotes when drafting the 

paper and then go through the footnotes changing them to full citations or ibid. as appropriate. This will prevent 

two ibid. notes from being separated when editing or adding new material, making the second ibid. in error. 

CITING SCRIPTURE  

Turabian allows for parenthetical citation of biblical texts and does not require inclusion of the Bible in the 

bibliography (§§16.4.3; 17.8.2). Because there are so many modern translations, and sometimes different editions 

of those translations, NEBC students must follow these guidelines: 

• If you are referring to a biblical text but not quoting from it, use parenthetical citation. No version 

information is necessary (e.g. “…we must learn to love even our enemies (Matt 5:44).”). See “Classical 

Citation Exception,” page 1 of this Guide. 
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• If you are quoting the Kings James Version (KJV), you should use only parenthetical reference in the text 

and should not include this version in your bibliography. Do not include an abbreviation for this version in 

the parenthetical reference unless you are using another translation in your paper as well. 

• If you are quoting from any modern translation, include a full footnote on first quotation and include that 

translation in your bibliography. If you are quoting only from that translation (ESV in this example), you 

should include at the end of the footnote “All Scripture quotations from ESV.” All subsequent quotations 

from this version should be cited parenthetically (Matt 5:44). 

• If you are quoting primarily from one translation but also using others, include a full footnote on first 

citation and include a note that “All Scripture quotations from ESV unless otherwise noted.”). Include a full 

footnote on first quotation from other translations and include all translations (except KJV) in the 

bibliography. All subsequent quotations from any translation should be cited parenthetically (Matt 5:44) 

and an abbreviation for the translation should be included for any translation other than the primary one 

(Matt 5:44, ESV). 

Jesus commands His disciples, “Love your enemies and pray for those who 

persecute you.”1 While some suggest that this is in contrast to the OT command to 

love one’s neighbor, Jesus is likely drawing upon such OT teaching as “If your 

enemy is hungry, give him bread to eat, and if he is thirsty, give him water to drink” 

(Prov 25:21). 

___________________ 

1. The Holy Bible, English Standard Version (Wheaton, IL: Crossway Bibles, 2001), Matt 

5:44. All Scripture quotations from ESV unless otherwise noted. 

 

 

Always abbreviate the name of a biblical book in parentheses or footnote but spell out the name of the book in the 

text of the paper, contrary to Turabian. When abbreviating, use the standard abbreviated titles of biblical books 

provided for you below. NEBC uses the abbreviations of the SBL Handbook of Style  (Society for Biblical Literature, 

2nd ed., 2014; §§8.2; 8.3.1-2) for biblical books, not the abbreviations listed in Turabian.  Do not capitalize the word 

"book." Always use Arabic numerals (1, 2, 3) for numbered books, not Roman (I, II, III), and use a non-breaking space 

between the number and the book name so that the number cannot be orphaned at the end of a line. In MS Word 

you can insert a non-breaking space by holding down the <CTRL> and <SHIFT> keys and typing the space. No period 

is needed with these abbreviations, as in the example above. Separate the chapter and verse with a colon (e.g., Ps 

90:4). 
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OLD TESTAMENT  NEW TESTAMENT 

Genesis   Gen Ecclesiastes  Eccl   Matthew  Matt  1 Peter  1 Pet  
Exodus   Exod Song of Solomon  Song  Mark  Mark  2 Peter  2 Pet  
Leviticus   Lev Isaiah  Isa  Luke  Luke  1 John  1 John  
Numbers   Num Jeremiah  Jer  John  John  2 John  2 John  
Deuteronomy   Deut Lamentations  Lam  Acts  Acts  3 John  3 John  
Joshua   Josh Ezekiel  Ezek  Romans  Rom  Jude  Jude  
Judges   Judg Daniel  Dan  1 Corinthians  1 Cor  Revelation  Rev 
Ruth   Ruth Hosea  Hos  2 Corinthians  2 Cor   
1 Samuel   1 Sam Joel  Joel  Galatians  Gal  
2 Samuel   2 Sam Amos  Amos  Ephesians  Eph  
1 Kings   1 Kgs Obadiah  Obad  Philippians  Phil  
2 Kings   2 Kgs Jonah  Jonah  Colossians  Col  
1 Chronicles   1 Chr Micah  Mic  1 Thessalonians  1 Thess  
2 Chronicles   2 Chr Nahum  Nah  2 Thessalonians  2 Thess  
Ezra   Ezra Habakkuk  Hab  1 Timothy  1 Tim  
Nehemiah   Neh Zephaniah  Zeph  2 Timothy  2 Tim  
Esther   Esth Haggai  Hag  Titus  Titus  
Job   Job Zechariah Zech Philemon  Phlm  
Psalms   Ps(s) Malachi  Mal  Hebrews  Heb  

Proverbs  Prov     James  Jas  

  

 Revelation 3 begins with the letter to the church in Sardis.   

 Rev 3 begins with the letter to the church in Sardis.   

 The book of Philippians includes several athletic and sport metaphors.  

 The Book of Philippians includes several athletic and sport metaphors.  

 Ephesians 4:1-10 expresses Paul’s desire for unity among the believers.  

 Eph 4:1-10 expresses Paul’s desire for unity among the believers.  

Do not write out the numbers either in your text or in your citations. Avoid beginning a sentence with a number 

(§23.1.2.1). 

 In 1 John 5:14-15…. 

 1 John chapter five verses fourteen and fifteen  

 First John 5:14-15 

 I John 5:14-15  
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If some of the reference information is already mentioned in your sentence, you may omit it from the note to avoid 

redundancy.   

In 1 John, the author expresses a firm belief that we can trust God to 

hear our prayers (5:14-15).  

For ranges of verses, follow these guidelines:    

  

Use a hyphen to create a range of verses:  

 Eph 4:1-10  
 

Use a hyphen to create a range of chapters:  

 John 15-17  
 

Use a comma to show a verse was omitted:  

 Mark 5:1,3  
 

Use a semicolon to show a chapter was omitted:  

 Mark 5;7  
 

Use a hyphen to show a continuous run across a chapter break:  

 Exod 19:14-20:2  
 

Use semicolons to separate passages within a book:  

 Lev 14:1; 15:6; 20:7  
 

Use semicolons to separate references from various books:  

 Ezek 14:1; Mark 7:7; John 3  
   

In study Bibles such as The HarperCollins Study Bible or The New Oxford Annotated Bible, special articles and notes 

(usually at the bottom of the page) are not part of the biblical text. Study notes are written by authors or editors 

whose names are included in the front matter of the study Bible.   

If you use information from these notes in your paper, all the relevant information from the specific study Bible and 

notes must be included as a regular footnote (not the standard parenthetical citation for citing Scripture), with a 

corresponding bibliography entry. Follow the guidelines in §17.1.8.2 for creating a correct footnote and bibliography 

entry.  
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3. Sophie Laws, “The Letter of James,” in The HarperCollins Study Bible: New Revised 

Standard Version, with the Apocryphal/Deuterocanonical Books, ed. Wayne A. Meeks et al. (New 

York, NY: HarperCollins, 1993), 2269 

5. Laws, “James,” 2264. 

Laws, Sophie. “The Letter of James.” In The HarperCollins Study Bible: New 

Revised Standard Version, with the Apocryphal/ Deuterocanonical Books, 

edited by Wayne A. Meeks et al., 2260-70. New York, NY: 

HarperCollins, 1993.   

 
CITING BIBLICAL COMMENTARIES  

Citing biblical commentaries can be difficult because they are published in a variety of formats, which all require 

different types of citations. The most important determining factor is whether the commentary is part of a series or 

part of a multivolume work.  

Many biblical commentaries appear as part of a series, where each work is considered a monograph (its own 

complete book), but is part of a titled series of books all using the same general format.  

When working with a single volume in a commentary series, follow the instructions in §17.1.5. Distinguish carefully 

between the volume title and the series title: italicize the volume title (like any book title), but keep the series title 

plain. List any editors or translators after their respective works.  

18. Peter Enns, Exodus, NIV Application Commentary Series, ed. Terry Muck. (Grand  

Rapids, MI: Zondervan, 2000), 35-6. 

20. Enns, Exodus, 55. 

Enns, Peter. Exodus. NIV Application Commentary Series, edited by Terry Muck. 

Grand Rapids, MI: Zondervan, 2000. 

A multivolume commentary differs from a commentary series in that each individual publication is seen as a piece 

of the greater total work. When citing an individual volume in a multivolume commentary, include the name of the 

whole commentary first (along with its general editors), followed by the specific volume number and title (see 

§17.1.4.1).  

33. Douglas Stuart, Word Biblical Commentary, ed. Bruce M. Metzger, David A. 

Hubbard, and Glenn W. Barker, vol. 31, Hosea-Jonah (Grand Rapids, MI: Zondervan, 2014), 29.  

Stuart, Douglas. Word Biblical Commentary. Edited by Bruce M. Metzger, David 

A. Hubbard, and Glenn W. Barker. Vol. 31, Hosea-Jonah. Grand Rapids, 

MI: Zondervan, 2014. 
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Since multivolume commentaries often combine treatments of several biblical books within a single volume, it is 

common for a different author to write the commentary on each biblical book within the volume. In this case, treat 

each author’s commentary like a chapter in a book written by several authors (see §17.1.8):  

2. John H. Sailhamer, “Genesis” in The Expositor’s Bible Commentary, rev. ed., ed. 
 

Tremper Longman III and David E. Garland, vol. 1, Genesis - Leviticus (Grand Rapids, MI: 

Zondervan, 2008), 89-100. 

6. Sailhamer, “Genesis,” 126. 

Sailhamer, John H. “Genesis.” In The Expositor’s Bible Commentary. Rev. ed. 

Edited by Tremper Longman III and David E. Garland. Vol. 1, Genesis – 

Leviticus, 21-332. Grand Rapids, MI: Zondervan, 2008. 

For more help with citing commentaries, please consult your Turabian Manual.    

CITING CLASS LECTURES & NOTES  

If you would like to reference information from a course—like your class notes, a handout from your professor, or a 

PowerPoint slide—follow the directions in §17.6.2, giving as much specific information as possible.   

12. Deborah Woodcock, “How to Write an Introduction” (lecture handout, GRMG103 

English Composition I, Northeastern Baptist College, October 14, 2016), 3 

Woodcock, Deborah. “How to Write an Introduction.” Lecture handout, GRMG103 

English Composition I, Northeastern Baptist College, October 14, 2016. 

ANNOTATED BIBLIOGRAPHY  

An annotated bibliography is just like a regular bibliography except that it also includes a brief “annotation” or note 

of explanation with each bibliography entry. When you’ve been assigned an annotated bibliography, you will need 

to write a one to two sentence summary of each work along with an explanation of the work’s usefulness to your 

paper topic. Your professor may require other elements in the annotation as well, such as author information, 

analysis, or plans for use.  The annotation must be in your own words. DO NOT copy/paste an abstract from another 

source such as Amazon. This means that you MUST (1) have access to the source and (2) read it yourself (or at least 

scan/survey a lengthy work such as a book) in order to write an annotation.  
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After each bibliography entry, add your annotation for the entry on the subsequent line, using block indentation 

(similar to a block quotation). See §16.2.1 for more information.  

 
 

HOW TO INCORPORATE QUOTATIONS  

WHEN TO QUOTE 

One of the clearest traits of an unskilled writer is not knowing when to use a quotation or how to integrate a 

quotation into his argument. There are several good reasons to quote from your source, but you must balance 

quotations, paraphrases, and summaries with your own fresh ideas (your own interpretations of and connections 

between the ideas of others). Don't simply create a "patchwork" or "quilt" of quotations. Keep these principles from 

§7.4 in mind:  

• Summarize when details are irrelevant or a source isn’t important enough to warrant more space. This 

works especially well when there is a need to condense a large part of your source's argument or a lengthy 

narrative. 

• Paraphrase when you can state what a source says more clearly or concisely than the source, or when your 

argument depends on the details of a source but not on its specific words. Paraphrasing involves much 

more than replacing a word or two in the quotation. You must completely rewrite the statement in your 

own words. Aside from technical terms which cannot be replaced in the subject, the wording and sentence 

structure should be distinctly different than the original.  

• Quote for these purposes:  

o The exact wording constitutes evidence that backs up your reasons.  

o A passage states a view you disagree with, and to be fair you want to state it exactly.  

o The quoted words are from an authority who backs up your view.  

o The quoted words are strikingly original.  

o The quoted words express your key concepts so compellingly that the quotation can frame the rest of 

your discussion.   

Broderick, James. The Literary Galaxy of Star Trek: An Analysis of References and 
Themes in the Television Series and Films. Jefferson, NC: McFarland & Co, 
2006.  
Star Trek may have been placed in the future, but many episodes bear 
homage to literary classics, a list which includes Hamlet, Ulysses, Moby 
Dick, and Dracula. Classic authors cited include Booker T. Washington, 
Edgar Allan Poe, and Shakespeare. Broderick, an English professor, 
examines plot lines and themes for all 5 series and 10 movies.  
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HOW TO QUOTE 

Every quotation involves three steps: Introduce, Insert, Integrate. 

Introduce  

There are many ways to introduce a quote to your reader. The main purpose is to help them transition from what 

you are saying to what the quoted author has to say. Your reader is struggling to understand and appreciate your 

argument or explanation. If you drop in a quotation with no introduction or context, the reader must stop and search 

at the bottom of the page (or the end of the document, in the case of endnotes) to figure out “who-said-it?” This 

slows his reading down considerably and greatly increases his difficulty in following your writing. ALWAYS introduce 

every quotation. You can vary the way you introduce the quotations for variety, “Gordon says,” “Williams suggests,” 

“Sidlow argues,” and so on. You will develop a repertoire for such introductions. Some words may even imply 

whether you agree with the author or not: “Dillon wisely proposes,” or “James demands.” See below under “Insert” 

for more elaborate ways to set the context of a quotation. 

Insert 

There are two basic methods for inserting a quotation in your text: drop-in and weave-in (§7.5).  

1. Drop-In. Drop in the quotation as an independent sentence or passage, introduced with a few explanatory 

words. In a drop-in, the quotation is a self-contained “package” dropped into place with a brief introduction 

to set it up.  

Ballard says, “The Psalms and Proverbs hold an important lesson for Christians 

today: amongst the vicissitudes of life, God’s promises hold fast.”3 

Alternatively, consider providing more connection between the ideas about which you are writing and the 

quotation’s substance:  

Ballard suggests that the most important principle expressed in these passages is 

that God does not go back on His word: “The Psalms and Proverbs hold an 

important lesson for Christians today: amongst the vicissitudes of life, God’s 

promises hold fast.”3 
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2. Weave-In. Weave distinctive words, phrases, or clauses of the source into the grammar of your sentence:  

Most scholars focus on the human or emotional quality of the Psalms and 

Proverbs, but Ballard points out that an “important lesson for Christians” 

in these passages is that “amongst the vicissitudes of life, God’s promises 

hold fast.”3 

In this case, you incorporate the words or phrases which make the original unique and quoteworthy, while 

paraphrasing the overall argument of the source and interacting with it at the same time.  

Integrate 

The third step to using a quotation is integration, which involves explaining and interpreting the quotation. First and 

briefly, you need to summarize and explain what the author said, i.e., re-state what you think the author is saying in 

the quote (and this might take a few sentences if the ideas in the quotation are complicated). This step is essential 

to making sure that you and your reader are on the same page before moving on to the next part. It's unpleasant 

and time-consuming to have to go back and read a quotation several time to make sure that you understand it. Help 

your reader flow smoothly through your argument by summarizing what you want the reader to get from the 

quotation. 

But second, and more importantly, you need to interpret and analyze what the author is saying. Unlike when you 

summarize the quote to explain its meaning, when you analyze you are adding something to the text, not just 

repeating it. You analyze a passage by noting something in it that is not on the surface: most dramatically, a 

contradiction in it or a subtext that the author did not intend, or less dramatically (but more commonly), an 

interesting ramification it suggests or an implicit connection you see it has to other points. In this process, you need 

to link your analysis or interpretation back to your own argument because analysis is merely a digression if it does 

not connect up with your own claim.  

In other words, you never want to let your readers interpret quotes on their own--you always want to be the 

mediator of all quotes, guiding your reader through them and through their connection to your thesis. Don’t let your 

reader come to their own conclusions about a quote; always tell them how you want them to understand it and how 

it supports your argument.   

Block Quotations  

When a quote consists of five or more lines, it should be set off as an indented block (see §25.2.2):  

• Single space the entire quote  

• Leave a blank line before and after  
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• Do not add any quotation marks, but keep any that exist within the original quotation  

• Indent the entire quotation ½ inch on the left  

Modifying Quotations  

Remember to quote exactly as written, aside from the following exceptions outlined in §25.3.  

1. Typo. If a quote has a typo that might impede meaning, you can fix it by using square brackets to replace 

the misspelled word with a correct one:  

DaVille claims, “Without remose, the sociopath has no stopper.”4  

DaVille claims, “Without [remorse], the sociopath has no stopper.”4  

  

2. Fit. If you wish to weave the quotation into your own sentence, you can modify the quotation to fit the 

grammar of your sentence—so long as you don’t change its meaning, and you clearly indicate added or 

changed words with square brackets and indicate deletions with three spaced dots (called an ellipsis). See 

§25.3.2 for special circumstances. Here is a full quotation, drop-in style: 

Posner focuses on religion, not for its spirituality but for its social 

functions: “A notable feature of American society is religious 

pluralism, and we should consider how this relates to the efficacy of 

governance by social norms in view of the historical importance of 

religion as both a source and enforcer of such norms.”4  

 

This version modifies the quotation to fit the grammar of the writer’s sentences:  

In his discussion of religious pluralism, Abraham Posner says of 

American society that “a notable feature . . . is [its] religious 

pluralism.” Posner believes we should consider how its social norms 

affect “the efficacy of governance . . . in view of the historical 

importance of religion as both a source and enforcer of such norms.”4  
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Avoid overdoing ellipses and brackets as you may leave the reader wondering why you left so much out. In 

such a case, it may be better to paraphrase rather than quote.  

FORM AND STYLE RULES  

The following rules on form and style override those of Turabian's Manual or specify which option offered by the 

Manual we will use as our standard at NEBC. As always, professor requirements will always supersede this guide.   

TURABIAN  RULE OR GUIDELINE  

§15.4.1.3  If a footnote or bibliography entry’s URL is a very long string of characters, the writer should 

break it after a slash mark (/), ampersand (&), or an equals sign (=) and continue it on the 

next line.  

§16.4.1  The shortened title in a shortened footnote should include up to 4 distinctive words from 

the full title.  

§17  NEBC exclusively uses the footnotes-bibliography style. Endnotes and parenthetical notes 

are  permitted only for those exceptions listed on pages 1-2 of this Guide.  

§17.2; §24.1.2 For footnotes, spell out the full title of journals and standard reference works in the first 

entry, followed by the abbreviation in parentheses.  Use the abbreviation in all subsequent 

footnotes.  

§§17.4-17.6 Theological reference works, newspaper articles, and unpublished interviews should be 

footnoted and listed in the bibliography.  

§17.8.2; §24.6  Rather than those listed in Turabian, use the abbreviations of SBL Manual of Style listed in 

the  chart on page 13 of this Guide.  

§21.1; §A.1.3 Terminal punctuation (e.g. a period at the end of a sentence) should be followed by one, not 

two, spaces.  

§21.2.2  The ‘Oxford’ comma is required.  

§22.3.1.1  Use Headline style (capitalize the first letter of all important words) for titles, headings, and 

subheadings.  

§23.1.3  Writers may use the % sign in the course of the text in place of the word percent, but must 

do so consistently throughout.  

§24.2 When you refer to a source for the first time in the text of your paper, use the author’s first 

and last name. When you mention the source thereafter, use just the last name. Never refer 

to an author by his/her first name. Do not use titles except where necessary.  

§24.2.3  The writer may choose whether to include periods within academic degrees, but he must be 

consistent with that style throughout the entire paper.  
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§24.4.3  When citing dates before Christ, use the year and BC (no periods), e.g. 57 BC. When 

citing dates within the first millennium after Christ, use AD (no periods) and then the 

year, e.g.  AD 70.  

§25.2.2  Use block-indent style for quotations that run five or more lines in length.  Use the 

paragraph indent feature in MS Word (in the Paragraph block of the Home tab) so that any 

necessary reformatting or correction will not require manual realignment.  Indent the 

quote ½ inch from the left margin. Do not add quotation marks. Use single spacing 

between the lines within the quote, with an empty line before and after. If the quotation 

begins a paragraph in the source, the first line of the block quotation should be indented 

another ½". 

§A.1.1  Set all four page margins to be one inch on each page.  

§A.1.1  The bottom line of typed material (whether text or footnote) on any page must not be less 

than 1 inch from the bottom of the page, nor more than 1½ inches from it.   

§A.1.2  Use 12-point Times New Roman font.  

§A.1.3  Indent paragraphs, block quotations, and the second and subsequent lines of bibliographic 

entries ½ inch.   

§A.1.4  Page numbers are to be placed in the upper right corner.  

§A.2.1.2 ; Figure A.1  Use the “Title Page for Class Paper” format for title pages. See the sample at the end of this 

guide. 

§A.2.1.6  Use the format shown in the Appendix for a Table of Contents page, if requested by the 

professor.  Most short papers (10 pages or fewer) do NOT need a Table of Contents. 
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  1  

The House of Seven Gables by Nathaniel Hawthorne is a romantic tale of mysterious curses, 

hidden secrets, bloody deaths, ghostly spirits, and magic.1 At the same time, the book realistically 

paints scenes of everyday life; cooking breakfast, the petty troubles of learning to earn wages, and 

the cherished interaction between the young and old.2 With The House of Seven  

Gables, Hawthorne is creating something daring: “If the realism of The House possesses in  

Hawthorne’s eyes a closer relation to nature and real life, its hereditary curses and magical 

portraits constitute a romance mode that is even more wild and extravagant.”3   

Essentially, Hawthorne is using the reality of the every-day to accentuate romantic 

elements. Thus, in the book one finds dark terrors hidden behind friendly faces. Likewise, there 

are streams of noble reconciliation and love coursing through the novel under cover of flower 

gardens and cent shops. Because of this mesh of the common with the extraordinary in The  

House of Seven Gables, one of the book’s major ideas is that outward appearances cloak the 

hidden truth. To demonstrate this theme that appearances are misleading, Hawthorn uses the 

characters of Hebzibah, Judge Pyncheon, and Uncle Venner.  

When the reader first meets Miss Hepzibah Pyncheon, it is apparent that she is seen as a 

stern woman. The town has established “her character as an ill-tempered old maid,” and as a 

neighbor puts it, “she’s a real old vixen.”4 One aspect of her outward appearance of sternness is 

her perceived fierceness. As Hepzibah begins a new era in her life as a working woman, she goes   

 
1. Jane Lundblad, Nathaniel Hawthorne and the Tradition of the Gothic Romance (New York, NY: Haskell 

House, 1964), 17-24.  

  

2. Richard H. Brodhead, Hawthorne, Melville, and the Novel (Chicago, IL: The University of Chicago Press, 

1976), 77.  

  

3. Ibid.  

  

4. Nathaniel Hawthorne, The House of Seven Gables: A Romance, Signet Classic ed. (New York, NY: The 

New American Library Inc., 1961), 36, 54.  

Sample text page 
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1  

  

Not the Way It’s Supposed to Be: A Breviary of Sin, by Cornelius Plantinga Jr. Grand Rapids: 

Wm. B. Eerdmans Publishing Co., 1995. Pp. 199.  
  

  Plantinga served as Professor of Systematic Theology for twenty years at Calvin 

Theological Seminary, and is now the residing President. His major works are theological in 

content, but his writing style is distinguished from other theologians’ as being skillfully current, 

captivating, and free-spoken. In this Breviary of Sin, Plantinga follows the standard he set with 

earlier books by writing on an aspect of the Christian life based in theology. He engages his 

readers and challenges them to a new perspective on sin that rises above the assumed, the 

sanctioned and the unspoken in the exploration of truth.  

The basic premise of the book is that the shalom of God has been vandalized. The peace 

that is God’s design for creation and redemption has been unkept. Sin is defined as “a culpable 

and personal affront to a personal God,” a God who “hates sin not just because it violates his 

law,” but “because it violates shalom, because it breaks the peace, because it interferes with the 

way things are supposed to be” (13-4). Sin is something beyond just a breach of law, but a  

“breaking of the covenant with one’s savior,” an act more deeply at odds with God, with all of 

creation, and with one’s very being (12). Building on this theological standpoint, the rest of the 

book is a depiction and analysis of the different manifestations of sin, the effects of sin in the 

human life–on an individual and global scale–and the ways humanity tries to evade sin.  

Plantinga poignantly explains the idea of sin in relation to corruption, thereby unveiling a 

truth about God’s design of creation. “God orders things into place by separating and sorting 

them. At the same time God binds things together” (29). The pattern for life consists of 

“distinction and union and distinction-within-union that would give creation strength and 

beauty” (29). The inherent strength and beauty of the universe was weakened and trashed at the   

Sample Book Review: Note inclusion of bib entry with the total number of 

pages in the work at the head and parenthetical reference of work reviewed. 


